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Introduction
VuePrint is a program that lets you display, manipulate, print, and save graphics files, while 
at the same time playing sound files.    VuePrint supports graphics displays and printers that 
operate with the Microsoft Windows 3.1 operating environment, using at least a 386 
microprocessor.

Some of the main features of VuePrint are:

Reads and writes 6 different types of graphics files (GIF, BMP, PCX, TGA, JPG, TIF)
Reads and writes internet graphics files in the uuencode format
Has a built-in screen saver (formerly a separate program - VueSav)
Includes a slide show feature with more than a dozen options
Displays multiple images (frames) in a window (contact sheets)
Can display any type of graphics file on any type of graphics display or printer 

(dithers)
Supports copying to the clipboard, and pasting from the clipboard
Uses 12 different effects for repainting the screen
Has menu options to install and remove VuePrint

The two main design goals of VuePrint are speed and ease of use. VuePrint is significantly 
faster and easier to use than most other graphics viewers. VuePrint can scale images to fill a
window automatically, without distorting the image shape. It has a cropping feature to 
remove borders from around images, full support for playing sounds and controlling 
multimedia devices such as CD players and videodisks. While VuePrint has many features, 
all are integrated in an easy to use menu system.

VuePrint lets you display, print, and play files you select while running the File Manager. It 
also supports dragging a file from the File Manager and dropping it into the VuePrint window.
VuePrint is fully integrated with the Windows Program Manager, giving full control over all 
options from the command line. It can also be used as a viewer subsystem for other 
programs such as the Internet Mosaic program.

VuePrint automatically detects the display type, and uses a pattern of dots in a dither 
pattern on the display when there are fewer colors available than the image requires. If 
Options|Auto Dither is selected, dithering is used when the image uses colors that are not 
available. Otherwise, dithering is used when the display has fewer colors than the image.    
This lets you use VuePrint on all laptop computers, as well as run multiple copies of VuePrint 
at the same time.    Even when multiple pictures require more colors than are available, 
VuePrint will make a best effort to display the images.

Just as VuePrint tries to accommodate displays that have too few colors, it also tries to run 
on systems with limited memory.    If an image will not fit in memory, VuePrint still makes a 
best effort to display the image by dropping alternate pixels until the image fits in memory.

To use VuePrint, you will need a personal computer that is running Microsoft Windows 
version 3.1 or higher. You will also need at least a 386 microprocessor. VuePrint will work 
with any Windows printer and display, including Hercules, EGA, 16-color, 256-color, 16-bit 
color, and 24-bit color displays.



Registering
VuePrint may be used and evaluated during a 15 day free trial period.    If you decide to 
register your copy of VuePrint, you will get:

o free upgrades (if you download them yourself).    I released a new version of 
VuePrint every few months in 1994, all of which were free upgrades to 
registered users.    My competitors do not do this, and neither do vendors of 
other commercial programs.

o three programs in one - a viewer, a screen saver, and a program to read and 
write internet graphics files that are in the <uuencode> format.    Normally 
you would have to buy each of these three programs separately. 

o the right to install VuePrint on three other computers that you use.    Since 
many people use multiple computers, this is more convenient and economical 
than registering multiple copies. 

o free support for VuePrint directly from the author via electronic mail (e-mail). 

o a serial number that disables the registration reminder. 

o Pro/32 Edition of VuePrint (if you download it yourself).    This edition of 
VuePrint is for systems that can run WIN32 programs, including Windows NT, 
Windows 95, and Windows 3.1 with win32s installed.    It is available from 
America Online, CompuServe, and most Internet-connected services by using 
the FTP (File Transfer Protocol) capability of these services.      When you 
register VuePrint, you will receive instructions on how to download this 
software.    The Pro/32 Edition is almost twice as fast as the 16-bit version, 
especially when reading JPEG files.

The $40 registration fee can be paid three different ways:

1) If you want to pay the $40 registration fee by credit card, please send your 
credit card number, expiration date, and full name (as it appears on the card) 
via electronic mail (e-mail) to either 71470,3236 on CompuServe or 
EdHamrick@aol.com on America Online. When I receive this information, I will 
send you your permanent VuePrint serial number by e-mail. There is no 
additional charge for registering by credit card.    I can most credit cards, 
including Master Card, Visa, American Express, Eurocard, Carte Blanche, 
Diners Club, and JCB.    I am not able to accept Discover Card.

2) If you have a CompuServe account, you can use the on-line software 
registration service. This service will charge your account $40, and will 
automatically send me an e-mail message notifying me that you have 
registered. To use this service, go to the SWREG forum on CompuServe, and 
use Registration ID 1883. I will respond by e-mail with your permanent 
VuePrint serial number (usually within 24-hours).    There is no additional 
charge for using the SWREG service. 

3) If you would prefer to register by surface mail, please send the $40 
registration fee to:

Hamrick Software
4171 E. Rockledge Rd.
Phoenix, AZ 85044-6771



Please include either a check or a credit card number/expiration 
date/signature.    If you include your e-mail address with your payment, I will 
send you your permanent VuePrint serial number by e-mail.    Otherwise, I will 
send it by surface mail.    Cash in equivalent amounts of other currencies is 
also accepted.    If you are an America Online member, your screen name is 
the same as your e-mail address.

If you need a temporary serial number immediately, I have set up a 24-hour answering 
machine that you can call to get a temporary serial number. Call (602) 759-3966 to get a 
temporary serial number that will disable the registration reminder for an additional 15 days.
Note that this temporary serial number can only be entered once, and additional temporary 
serial numbers obtained by phone can not be entered into VuePrint.

Note that you will not receive a diskette or a manual in the mail when you register, since you
already have the complete VuePrint program, including the available documentation (this 
help file).    This allows me to not charge anything for upgrades, since you can download 
them at your convenience.

Once the 15 day evaluation period ends, VuePrint displays a reminder that the evaluation 
period has ended, and a request to register the program. This reminder was carefully 
designed to not interfere with further evaluation of the program past the 15 day period - all 
functionality is still enabled after the evaluation period.

I really appreciate getting e-mail containing suggestions for improving VuePrint, since this is 
the main way I prioritize the features that get added to each new version. Most of the new 
features in VuePrint have been requested by a few customers, and some features had been 
requested by dozens of people.    If you are one of the people who suggested some of the 
new features in VuePrint, thanks.



Screen Saver
VuePrint can be installed as both a viewer and as a screen saver.    When installed as a 
screen saver, it displays graphics files on the screen when there is no activity for more than 
5 minutes.    The default setup causes it to search out all graphics files on the same drive as 
Windows, and to display these graphics files sequentially every 15 seconds.    Any keypress, 
mouse click, or mouse movement of more than 16 pixels will cause the program to exit.    
Each time the screen saver exits, it remembers the last file that was displayed, and starts 
over again after 5 minutes of inactivity displaying this same file.

The screen saver can by installed by choosing Utilities|Install Screen Saver.    The screen 
saver is just a copy of VUEPRINT.EXE that is copied into the Windows directory (normally c:\
windows) and named VUESAVER.SCR.    This help file is also copied into VUESAVER.HLP.

All the options for the screen saver are stored in the Windows directory in the file 
VUESAVER.INI.    Any VuePrint option can be set up in this file.    For example, to disable the 
mouse during the screen saver, set the option <IgnoreMouse=1>.

To configure the screen saver, you can either choose the Utilities|Configure Screen Saver 
menu item, or choose the <Setup> button from the <Desktop> Control Panel.

All the options that can be set on the screen saver setup screen are the same as the options 
in the VuePrint menus.    All these options do is set up the VUESAVER.INI configuration file.



File Formats
VuePrint reads four types of files:

Image files (.GIF, .BMP, .DIB, .PCX, .TGA, .JPG, .TIF)

Sound files (.WAV, .MID, .MCI)

Slide Show files (.SLI)

Uuencoded files

A file that has an image file extension or an unrecognized extension is automatically 
recognized by the first few bytes in the file. If the first few bytes of the file are not 
recognized, the software checks to see if the file is a Macintosh GIF or JPEG/PICT file.    If it is 
a Macintosh GIF or JPEG/PICT file, the header information is skipped and the file is read 
normally.

Sound and Slide Show files are recognized by their extensions.

GIF Files (.GIF)

VuePrint will read both GIF 87a files and GIF 89a files.    GIF files that have Macintosh headers
are also recognized.    The only GIF 89a attribute that is used is transparency, the other GIF 
89a extensions (such as text overlays) are ignored. Multiple Image GIF files are supported, 
and the image that is displayed is the composite of all the multiple image segments.    
Comments that are contained in the GIF file are stored in the Comments window, and are 
saved when a GIF, JPEG, or TIFF file is written.

Bitmap Files (.BMP, .DIB)

All BMP and DIB bitmap formats are supported, including compressed and OS/2 bitmaps.

PC Paintbrush Files (.PCX)

PCX files that are version 3.0 or less are supported, including reading the 24-bit format.    The
CGA color palette information is ignored.    The <File|Save as...> option creates 8-bit PCX 
files.

Targa Files (.TGA)

All Targa file formats are supported.

JPEG Files (.JPG)

VuePrint reads JPEG files that use either the JFIF format (.JPG extension) or the Macintosh 
JPEG/PICT format.    Comments that are contained in the JPEG file are stored in the Comments
window, and are saved when a GIF, JPEG, or TIFF file is written.

TIFF Files (.TIF)

VuePrint reads TIFF files that conform to the TIFF 6.0 specification, including files 
compressed with LZW, CCITT Group 3, and CCITT Group 4 methods.    Tiled files are not 
supported.    Comments that are contained in the TIFF file are stored in the Comments 
window, and are saved when a GIF, JPEG, or TIFF file is written.



Sound Files (.WAV, .MID)

Standard WAV and MIDI files are supported.    If you only have the PC Speaker sound driver, 
you will need to select the Sound|Synchronous option.    MIDI files can not be played with the
PC Speaker sound driver.

Multimedia Command Interface Files (.MCI)

MCI files contain MCI commands. Refer to various Microsoft descriptions of MCI command 
strings for more details. In order for MCI files to interact properly with the slide show feature,
one MCI command should use the <notify> parameter. When the command completes, 
VuePrint will automatically issue the <close all> MCI command. For example, the following 
MCI file will play track two of an audio CD player, and will continue a slide show after the 
track completes:

# This script plays track two on an audio cd
open cdaudio alias cd
set cd time format tmsf
play cd from 2 to 3 notify

This MCI file will play an AVI animation file, and continue the slide show after it completes:

# This script plays an AVI file
open \dir\file.avi type avivideo alias avi
play avi notify

This MCI file will play an MMM animation file, and continue the slide show after it completes:

# This script plays an MMM file
open \dir\file.mmm type mmmovie alias mmm
play mmm notify

Slide Show Files (.SLI)

Slide Show files (.SLI) are just text files containing a list of image files, one file name per line.
This list can contain other .SLI files, which can refer to other .SLI files, and so on (up to eight 
times). A slide show list is also automatically created with you use the File|Open menu to 
select a single file.    A slide show list is also created when you choose the Slideshow|File 
spec menu.

Uuencoded files (.UU?)

Uuencoded files are commonly used on the Internet to convert image files into a text file 
that can be sent over the Internet as e-mail.    Please refer to the section on Internet 
Graphics for more details.



File Manager
VuePrint can be integrated with the Windows File Manager by choosing the Utilities|Install 
VuePrint to associate VuePrint with the Image, Sound, and Slide Show file types.    You can 
use Utilities|Remove VuePrint to disassociate VuePrint and restore the previous associations. 
When VuePrint is installed, you can use the File Manager to double-click on any Image, 
Sound, or Slide Show file, and VuePrint will be automatically started to display (or play) the 
file. VuePrint will also print images chosen in the File Manager.



Program Manager
VuePrint provides a complete command line argument processing system that gives you the 
capability to install different VuePrint icons to do different things. Because the command line
processing is also performed when VuePrint is started from another program, you can use 
VuePrint as a viewing subsystem for other applications. The command line can contain two 
types of arguments - options and file names. File names have complete wildcard support, 
and the additional feature that filenames ending in <...> will recursively descend a directory
tree looking for additional files.

The command line is processed from left to right.    Valid command line options can have the 
following forms:

-name
/name
-name=value
/name=value

If there is no value specified, the value 1 is used.

The names of the options are the same as those in the VUEPRINT.INI option file, and override
the settings in that file. Command line options can be abbreviated, are not case sensitive, 
and the first one matching the command line option is used. There are two additional 
command line options that are not used by the .INI file:

/directory=name
/print
/install

The /directory=name option changes the current drive and directory to <name>. This is 
useful when VuePrint is used as a subsystem of another program.

The /print option causes every file on the command line to be displayed and then printed.    
Only the first file sets up the printer options, the remainder use the same printer options.    
This lets you do unattended printing of large numbers of image files.

The /install option invokes the Utilities|Install VuePrint menu item when VuePrint starts up.



Interrupting
VuePrint has been designed to let you interrupt loading files, since this operation can 
sometimes take some time.    Any menu choices that need to read or change the current 
image will interrupt the currently loading file.    Other options that interrupt loading the 
current image include those that save and restore option settings, change the number of 
frames, install or remove VuePrint or the Screen Saver, invoke Help, or display any dialog 
box.

For example, pressing the <X> key while a file is being loaded will execute the File|Exit 
command, causing VuePrint to immediately exit.



Options
There are about 75 different options that can be used for VuePrint.    These options are stored
in a file in the Windows directory, usually C:\WINDOWS\VUEPRINT.INI.    The name of the .INI 
file matches the name of the program.    For instance, if you copy VUEPRINT.EXE to 
VUETEST.EXE and then run VUETEST.EXE, the file C:\WINDOWS\VUETEST.INI is used to hold 
the options for this program.    This lets you install multiple copies of VuePrint, each with 
different options.

Each option has a default value, a minimum value, and a maximum value.    In addition, 
there are different default values when the program is run as a viewer and as a screen saver.

The following options can be used in the .INI file and on the command line. Their names, 
default values, default screen saver values, minimum values, and maximum values are:

Options from File menu

Option Name Default Saver Min Max
OpenIndex 9 6 1 10
SaveAsIndex 1 1 1 5
DeleteIndex 9 9 1 11
UudecodeIndex 1 1 1 2
UuencodeIndex 9 9 1 10
UuencodeLines 400 400 1 none
TopMargin 0 0 0 none
LeftMargin 0 0 0 none
RightMargin 0 0 0 none
BottomMargin 0 0 0 none
ShowComments 0 0 0 1
ShowHistory 0 0 0 1

Options from Image menu

Option Name Default Saver Min Max
Rotate 0 0 0 7
Brightness 5 5 1 9
Contrast 5 5 1 9
Invert 0 0 0 1

Options from Sound menu

Option Name Default Saver Min Max
SoundEnable 1 1 0 1
SoundSynchronous 0 0 0 1



Options from Slideshow menu

Option Name Default Saver Min Max
RunSlideshow 0 1 0 1
ExitOnKey 0 1 0 1
ExitOnMouse 0 1 0 1
ExitOnLastFrame 0 0 0 1
ExitWhenDone 0 0 0 1
StopOnKey 0 0 0 1
StopOnMouse 0 0 0 1
StopOnLastFrame 0 0 0 1
StopWhenDone 0 0 0 1
IgnoreKey 0 0 0 1
IgnoreMouse 0 0 0 1
EnablePassword 0 0 0 1
RandomOrder 0 0 0 1
ImageDelay 5 15 0 none
SoundDelay 0 0 0 none

Options from Options menu

Option Name Default Saver Min Max
DisplayInColor 1 1 0 1
PrintInColor 1 1 0 1
PrintDithered 0 0 0 1
BackgroundRed 192 0 0 255
BackgroundGreen 192 0 0 255
BackgroundBlue 192 0 0 255
ForegroundRed 0 192 0 255
ForegroundGreen 0 192 0 255
ForegroundBlue 0 192 0 255
DitherQuality 2 2 1 3
Effect 1 12 1 12
AutoScale 0 0 0 1
AutoFit 1 1 0 1
AutoCrop 0 0 0 1
AutoDither 0 0 0 1
AutoComments 0 0 0 1
AutoSearch 0 1 0 1
AutoResume 1 1 0 1
RememberOptions 0 0 0 1
FramesAcross 1 1 1 999
FramesDown 1 1 1 999
FramesRandom 0 1 0 1
FramesAnnotate 1 0 0 1
FillWindow 0 1 0 1



Options from JPEG menu

Option Name Default Saver Min Max
JPEGTwoPass 0 0 0 1
JPEGUseDithering 1 1 0 1
JPEGUseMonochrome 0 0 0 1
JPEGBlockSmoothing 0 0 0 1
JPEGPixelSmoothing 0 0 0 1
JPEGWriteGIF 0 0 0 1
JPEGOutputMonochrome 0 0 0 1
JPEGOutputOptimize 1 1 0 1
JPEGOutputQuality 75 75 0 100
JPEGOutputSmoothing 0 0 0 100

Window position settings

Option Name Default Saver Min Max
XImage 0 0 0 999
YImage 0 0 0 999
WImage 1000 1000 1 1000
HImage 1000 1000 1 1000
MImage 0 0 -1 1

XComments 0 0 0 999
YComments 667 667 0 999
WComments 1000 1000 1 1000
HComments 333 333 1 1000
MComments 0 0 -1 1

XHistory 0 0 0 999
YHistory 667 667 0 999
WHistory 1000 1000 1 1000
HHistory 333 333 1 1000
MHistory 0 0 -1 1

Miscellaneous options

Option Name Default Saver Min Max
EnableCtl3d 1 1 0 1
EnableLargeDialogs 1 1 0 1

The options for controlling window positions are designed to be independent of the display 
resolution.    These values range from 0 to 1000, where 1000 is the full width (or height) of 
the display.    The option beginning with M is -1 for a minimized window, 0 for a normal 
window, and 1 for a maximized window.

VuePrint uses the 3-D controls library to give 3-D effects to dialog boxes.    It searches for the
file CTL3DV2.DLL in the Windows system directory to determine whether to use 3-D controls.
If you have this library, but want to disable the use of 3-D controls in VuePrint, you can 
change the <EnableCtl3d> option to 0 in the .INI file.    Some older display drivers cause 
General Protection Faults by causing stack overflow errors when this option is enabled.    The 
3D controls library is not used with Windows 95.

If you want to use the standard Windows File Open/Save dialogs instead of the larger 



Open/Save dialogs used by VuePrint, set the <EnableLargeDialogs> option to 0.    Some 
display drivers use an incorrect font size when displaying the VuePrint dialogs, causing them 
to be larger than a 640x480 screen.    Some systems using the Norton Desktop also need this
option to be set, especially when using a 640x480 screen.

If you want to produce uuencoded files that have more than 400 lines each, you can set the 
<UuencodeLines> option to a number larger than 400.    Note that the number of lines in a 
file may be larger than this if the total number of files would otherwise be larger than 36.    
The default value of 400 is set so these files can be sent in pieces via e-mail on America 
Online.

Note that all options are stored as a 16-bit signed number, so the maximum value for any 
option is 32767.



Mouse
The left mouse button can be used to select a rectangular subset of an image.    This subset 
of the image is used when displaying, printing, or saving an image.    The right mouse button
is used to move a zoomed-in image within the window (you will see a hand icon when 
moving).    A double-click of the right button will select the whole image.

When the left mouse button is clicked, and less than 16 pixels are selected, the image is 
zoomed by a factor of two, centered on the position of the mouse.    If the control key is 
pressed while the left mouse button is clicked, the image will be zoomed out by a factor of 
two.    If the shift key is pressed with the left mouse button, the image is cropped, and if the 
control and shift keys are both pressed, the image is rotated.

If the display has multiple frames and the left mouse button is clicked outside the current 
frame, the current image is painted in the clicked-upon frame.

If both mouse buttons are pressed at once, the program will exit.



Keyboard
Most menu items have a keyboard equivalent.    The key that corresponds to the menu item 
is displayed along with the menu.

The arrow keys on the keyboard will move a zoomed image.    If the shift key is pressed along
with an arrow key, the zoomed image will move in window-sized jumps.    If the control key is 
pressed along with an arrow key, the zoomed image will move in single-pixel jumps.    If the 
Alt key is pressed with an arrow key, the size of the zoomed area will be adjusted in single-
pixel jumps.

Long-running MCI commands can be aborted by pressing Control-Break.



Hints for Improving Display Quality
If you get a display that seems fuzzy (made up of lots of small dots), you probably have your
Windows display adapter configured for 16 colors.    To configure your display adapter for 256
(or more) colors, go to the Program Manager and open the <Main> window.    Then open the 
<Setup> window, and choose the <Options|Change System Settings> menu.    Choose a 
display mode that has 256 (or more) colors, and then press <OK>.    If you can not find a 
display mode for 256 (or more) colors for your display type, select the last item in the list 
<Other display (requires disk from OEM)...>.    You will have to insert the diskette containing 
the display driver for your computer.    This diskette probably came with your computer, or 
came with your display adapter if you bought it separately.

If your display still seems fuzzy when you configure your system for 256 colors, you probably
have the Effects option set to something other than Direct, or you have the number of 
frames across or down set to a number larger than one.    The reason for this is VuePrint 
needs to use a fixed palette for the display under these conditions, because two or more 
images (with 256 colors each) may be displayed on the screen at a time.    VuePrint has to 
make a compromise palette in order to display several images at the same time, and the 
compromise (fixed) palette is not always optimal for either image.    The solution to this is to 
configure your display for either 65536 colors or 24-million colors (if your hardware supports 
it), or to set the effect to Direct, and the number of frames across and down to one.

You might want to use the JPEG|Two pass option if your display adapter can only display 256 
colors.    If you get General Protection Fault (GPF)    errors when trying to display JPEG files on 
a 65536 color display, you need to use Two pass or need to get an updated display driver 
from the vendor of your display card.    This is especially true if the GPF is in a module named
64K_1024.DRV.

If you have several hard drives, you can set up an environment variable (TMP or TEMP) to 
tell VuePrint where to write temporary files when processing very large JPEG files with the 
JPEG|Two Pass option.

If you have a JPEG file that you suspect is bad, you can still view whatever is present in the 
file by turning off the JPEG|Two Pass option.



Internet Graphics
There are two sources of graphics files on the Internet, ftp (File Transfer Protocol) and usenet
(Internet news groups).

To use ftp to retrieve graphics files from an Internet site, make sure you have enabled binary
transfers (type BIN at the ftp> prompt).    If you are using the America Online ftp software, 
this is done for you automatically.

You can also find many different kinds of graphics files in the Internet usenet news groups.    
For instance, the alt.binaries.pictures... hierarchy contains the majority of the Internet traffic 
in graphics files.

The graphics files in the usenet news groups are usually in a <uuencoded> format (it stands
for Unix-to-Unix-Encoded).    These files are often broken up into several pieces, because 
there is a limit on the size of a file that can be sent by e-mail to some Internet systems.    A 
uuencoded file begins with a line that looks like <begin 660 file.gif>.    It is then followed by 
multiple lines that begin with <M> and are 61 characters long.    The last three lines are 
usually a line that is shorter than 61 characters long, a line with the single character <`>, 
and a line that contains <end> by itself.

A uuencoded file can also contain a few dozen lines of extraneous information at the top and
bottom of the file.    You do not have to edit these lines out by hand, since the VuePrint 
program automatically discards this information when processing a uuencoded file.

The first step to decoding these images is to download the uuencoded files to your hard 
drive on your computer.    If you are using America Online to access the usenet news groups, 
you can download these files by:

1) Double-click on the uuencoded article.
2) Repeatedly click the <More> button (to retrieve additional segments of the file)
3) When the <More> button is grayed out, choose File|Save As...
4) Choose a name like <file1.uu1>, <file1.uu2>, ... to hold the pieces of the file

Once you have downloaded the uuencoded files to your hard drive, use VuePrint to decode 
these files.    To decode these files, put the pieces of the file in order in files named 
something like <file1.uu1>, <file1.uu2>, ... <file1.uuN>.    (The ordering goes 
1,2,...8,9,a,b,c...).    Then choose File|Uudecode and press the control key at the same time 
as clicking each piece with the mouse to select the pieces of the file.    When you press OK, 
the pieces will be put together, and the original image file will be put in the same directory 
as the uuencoded files.    You can then use <File|Open...> to view these files.

There are two common problems people have in decoding internet graphics files.    The most 
common problem on America Online is not pressing the <More> button till it turns gray 
before choosing <File|Save As...>.    The other common problem is not selecting all the 
pieces of the file before pressing OK in the File|Uudecode dialog.



Limitations
VuePrint reads GIF, DIB, BMP, PCX, TGA and TIFF files that have a maximum width of 4096.    
JPEG files can have a maximum width of 2048.    All image files can have a maximum height 
of 6000.    An image can take up to 50% of the free memory.    If an image can not fit into the 
available memory, every other pixel and line is dropped until it fits.

If you are using the JPEG|Two Pass option, VuePrint will use up to 75% of the available 
memory for temporary storage of data for the second pass.    If you want to override this, set
up the environment variable TEMPMEM.    For instance, if you put <SET TEMPMEM=6m> in 
AUTOEXEC.BAT, VuePrint will use 6 million bytes of memory for temporary storage.    (You 
can also use k, K, or M as a suffix.)

The maximum number of files that can be selected in the File|Open is limited by a 16384 
character buffer for holding the file names.

MCI commands can be a maximum of 249 characters long.    The MCI command result can 
also be a maximum of 249 characters long.

If you set wallpaper to a bitmap that has 24 bits per pixel, Windows will refuse to start up if 
you restart your system with 8 (or fewer) bits per pixel.    If this happens, edit the file WIN.INI 
in the
Windows directory and delete the line <wallpaper=vueprint.bmp> in the section beginning 
with <[desktop]>.

If your system is running with a resolution of 640x480 and is using a system font other than 
the standard MS Sans Serif font (or has otherwise reduced the size of the displayable area), 
the file selection dialogs will not fit on the screen.    To fix this, edit the file c:\windows\
vueprint.ini and add the line <EnableLargeDialogs=0>.    If you use the file selection dialog 
without adding this option, press Escape to exit the dialog and try again.



Upgrading
You can obtain the latest version of VuePrint from America Online, CompuServe, and the 
Internet.    It is also available from other on-line services and several CD-ROM distributors.

America Online: Choose the <Go To|Keyword...> option and enter <Graphics>.    
Then select <Recommended Utilities>.    You can also go to 
keyword FTP access the ftp site below.

CompuServe: Go to the GRAPHSUPPORT Forum, Library 3 (GIF Viewers), and 
download VUEPRI.ZIP.      You can also GO FTP and access the ftp 
site below.

ftp: host name: ftp.primenet.com directory: /users/h/hamrick.

www: <http://www.primenet.com/~hamrick/>

After you register VuePrint, you may download the VuePrint Pro/32 Edition from the above ftp
site.    It is only available to registered VuePrint users who have access to an on-line ftp 
service.    The Pro/32 Edition of VuePrint is a 32-bit version that is up to twice as fast as the 
standard 16-bit version.    If youre using Windows 3.1 or 3.11, youll also need to obtain the 
win32s software to run this.
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File Menu
The File menu provides commands to open files, save files in five different formats, copy and
delete files, process uuencoded files, advance the slide show list, print images, control the 
comments and history informational windows, and exit the program.

Open... opens an image or sound file. You can select multiple files by 
using control-click to add single files, or shift-click to select a 
range of files. If only a single file is opened, the other image and
sound files in the same directory are added to the slide show 
list.    Only files of the type specified in the File Types control are 
added to the slide show list. 

Close closes the currently open files and clears the screen.    This can 
be used even while a file is being loaded.

Save as... saves the currently selected image in a file.    The file format is 
determined by the file extension.    If the file extension is not 
recognized, then the file format is determined by the File Type 
control in the dialog.    The image is saved in its rotated and 
cropped format, but at the original resolution of the image and 
with the original palette.    The contents of the comments 
window will also be saved to GIF, JPEG, and TIFF files. 

Save wallpaper... saves the currently selected image (rotated, clipped, and 
dithered) to the Windows directory.    The image is scaled up to 
the size of the screen if the AutoScale option is enabled, and is 
always scaled down to the size of the screen if larger than the 
screen.    This command then sets this file as the desktop 
wallpaper. 

Copy image to... lets you make a copy of the current image file. 

Copy sound to... lets you make a copy of the current sound file. 

Delete image... lets you delete the current image file. 

Delete sound... lets you delete the current sound file. 

Delete files... lets you delete a number of files at once. 

Uudecode... lets you decode files that have been encoded using uuencode.    
These files are commonly used for transmitting Internet 
Graphics in Internet news groups.    The files may contain extra 
header and footer lines, and files may contain parts of a 
uuencoded files, entire uuencoded files, or multiple uuencoded 
files.    The only restriction is that the files will be processed in 
alphabetical order.    The most convenient naming scheme is 
file.uu1, file.uu2, ... file.uu9, file.uua, file.uub, etc., but any 
naming scheme may be used as long as the files are in 
alphabetical order.    Note that you have to select all the files 
you want to decode by clicking on the first file in a series, and 
then using shift-click to click on the last file in a series, then 
press OK.



Uuencode... lets you encode files in the uuencode format.    Files are written 
using the same file name as the input file, but with 
extensions .uu1, .uu2, ... .uu9, .uua, .uub, etc.    The maximum 
number of lines per file can be changed by changing the option 
UuencodeLines.    This option is used to compute the number of 
files that must be written, and then the actual number of lines 
per file is computed to try to make each file roughly equal size.   
Very large input files may have more lines than expected, since 
at most 35 output files are created per input file. 

Next loads the next file in the Slide Show list. 

Previous loads the previous file in the Slide Show list. 

Random loads a random file from the Slide Show list. 

Print... prints the current image. 

Print setup... displays a printer setup dialog box. 

Print margins... lets you specify the size of the margins (in millimeters)    Note 
that these are not always margins to the edge of the paper, 
only margins relative to the print area.    If you want to be 
precise about the margins, your printer manual will probably 
give you information about the positioning of the print area on 
the paper.    There are 25.4 millimeters per inch, but an integral 
number of millimeters must be entered.    Note that often one 
dimension of the printed image will not extend all the way to 
the margin, since the aspect ratio of the image does not always 
match the aspect ratio of the print area. 

Show comments displays a window containing comments contained within the 
currently displayed image (up to 100 lines). 

Show history displays a window containing a log of the last 100 VuePrint 
events since the program was started. 

Exit exits VuePrint. 



Edit Menu
The Edit menu provides commands to exchange data with the clipboard.    It lets you copy 
and paste the current image, copy and paste the comment text associated with an image, 
and copy the picture in the window to the clipboard.    Note that the clipboard can hold either
an image or comments, but not both at the same time.    When an image is pasted from the 
clipboard the comments window is cleared.

Copy image copies the current image to the clipboard.    If the image has 24 
bits per pixel, it is converted to 8 bits per pixel before copying 
to the clipboard.    The image is copied in its rotated and 
cropped format, but at the original resolution of the image and 
with the original palette.    If the image is dithered on the 
display, it will not be dithered after copying to the clipboard. 

Paste image copies an image from the clipboard to the current image.    The 
clipboard must contain a bitmap, a metafile, or a device-
independent bitmap. 

Copy comments copies the text in the comments window to the clipboard. 

Paste comments copies text from the clipboard to the comments window. 

Copy window copies the current window to the clipboard.    The window is 
copied at the resolution of the window and with the same 
palette as the window. 



Image Menu
The Image menu provides commands to manipulate the current image.    Note that images 
are saved with the zooming, cropping, rotating, mirroring, and flipping applied, with the 
same brightness, contrast, and invert settings as currently displayed.    The brightness, 
contrast, and invert settings for the image are also used for adjusting the brightness, 
contrast, and invert settings on the printouts.

Zoom in zooms the image by a factor of two.    If the Options|Auto scale 
is selected, images smaller than the window will be scaled up to
fill the window. 

Crop crops borders off the edges of the image.    A border is detected 
by searching for borders that contain significantly fewer colors 
than the image as a whole.

Zoom out zooms out by a factor of two. 

Rotate rotates the image 90 degrees clockwise. 

Mirror mirrors the image horizontally. 

Flip flips the image vertically. 

Brighter increases the overall brightness of the image (and printout). 

Dimmer decreases the overall brightness of the image (and printout). 

More contrast increases the contrast (gamma) of the image (and printout). 

Less contrast decreases the contrast (gamma) of the image (and printout). 

Invert inverts the image.      This is useful if you want to print an image,
such as a map, that consists of white graphics on a black 
background.

Reset resets the image to the default zoom factor, rotation, 
brightness, contrast, and invert settings. 



Sound Menu
The Sound menu provides commands to manipulate the currently loaded sound.

Enable enables playing sounds. 

Synchronous enables playing sounds synchronously.    This is useful if you 
have a sound driver for the PC speaker, which requires playing 
sounds synchronously.    MIDI files can not be played using the 
PC speaker sound driver. 

MCI command... lets you enter an MCI command. 

Louder increases the volume. 

Softer decreases the volume. 

Replay replays the current sound. 



Slideshow Menu
The Slideshow menu provides commands to set up a slide show.    When the slide show is 
running, all other functions in VuePrint can be used.    The only thing that running a slide 
show does is advance to the next image or sound after the delay between sounds or images 
completes.    This menu also provides options for controlling what happens when a keyboard 
or mouse action happens while the slide show is running.

Run slideshow controls the running of slide shows. The list of files for the slide 
show can come from two places - multiple files opened with File|
Open ,or <File spec...>.    The order of displaying files in a slide 
show is either the next, previous, or a random file in the list, 
depending on how the current file was selected. If the <Random
order> option is selected, then a random file is always selected 
as the next image in a slide show sequence.

Go to slide... lets you enter the file name of a file that is already in the slide 
show list.    This file, if it is found in the list, will be loaded and 
displayed, otherwise the current file will be reloaded and 
displayed. 

File spec... lets you enter the file specification of files for the slide show list.
The first file found is loaded and displayed.    Note that this file 
spec can be a single file name of a .SLI file (e.g. c:\test\
slides.sli), a directory where images are located (e.g. c:\
images\), a wildcard specification (e.g. c:\images\*.gif), or a 
special name indicating that all subdirectories should be 
searched (e.g. c:\images...).    If a directory name is specified, 
and the Auto Search option is enabled, all subdirectories will 
also be searched.    The types of files that are selected are those
selected in the File|Open dialog box.

Exit on key exits the program when any key is pressed while a slide show is 
running. 

Exit on mouse exits the program when a mouse button is pressed, or when the
mouse is moved while a slide show is running. 

Exit on last frame exits the program after the last frame (i.e. lower right hand 
corner) is displayed.

Exit when done exits the program after all the files in a slide show are 
displayed. 

Stop on key stops running the slide show when any key is pressed. 

Stop on mouse stops running the slide show when a mouse button is pressed, 
or when the mouse is moved. 

Stop on last frame stops running the slide show after the last frame (i.e. lower right
hand corner) is displayed.

Stop when done stops running the slide show after all the files in a slide show 
are displayed. 



Ignore key ignores all keystrokes while a slide show is running. 

Ignore mouse ignores all mouse buttons and mouse movements while a slide 
show is running. 

Enable password prompts you for the screen saver password (if it has been set 
up) before stopping a running slide show. 

Random order displays images in the slide show list in random order while the 
slide show is running. 

Set password... lets you set up or change the screen saver password.    If it has 
previously been set up, you need to enter the old password 
before being able to set up a new password. 

Image delay... lets you enter the minimum delay between successive images 
in a slide show. 

Sound delay... lets you enter the minimum delay between successive sounds 
in a slide show. 



Options Menu
The Options menu provides commands to manipulate various VuePrint options, and to save 
and restore all options (including window positions).

Display in color enables displaying images in color. 

Print in color enables printing images in color. 

Print dithered lets you print images using VuePrint dithering.    You may want 
to enable this option when working with some types of dot-
matrix printers that normally use a coarse pattern to 
approximate continuous tone images.    If you use this option, 
set up the printer dialog to use no dithering since it is 
redundant and will just make the printout take longer.

Background color... lets you choose the background color for images, which is used 
for the border around images. 

Foreground color... lets you choose the foreground color, which is used to display 
text and borders for multiple frames. 

Dither quality lets you trade off between dither quality and speed.    The low 
quality setting paints the screen the fastest, and the high 
quality setting looks the best.    The default is the medium 
quality setting. 

Effect lets you choose how the screen is repainted.    There are 12 
different effects you can choose for repainting. 

Auto scale automatically scales images to fill the window.    It maintains the
width/height ratio of the image, so one dimension of the image 
may not extend to the edge of the window.

Auto fit when the <Auto scale> option is off, automatically reduces 
large images to fit inside the window.    Also causes the areas of 
am image selected by the mouse to be fit within the window 
borders.

Auto crop automatically crops images after loading.    The borders around 
an image are cropped if they contain substantially fewer colors 
than the image as a whole.

Auto dither automatically dithers images if there is a substantial percentage
of the picture that can not be represented accurately with the 
colors that are available on the display. 

Auto comments automatically displays the comments window after loading an 
image that contains comments, and removes the comments 
window if the image contains no comments.    Only GIF, JPEG, 
and TIFF files can contain comments. 

Auto search automatically searches all subdirectories (up to 8 levels deep) 
for image files when a directory is specified in the File spec... 
option. 



Auto resume automatically saves the current directory and current image on 
exit. If the slide show is running when the program starts, the 
slide show starts up where it left off. The current directory is 
also restored when the program is restarted, unless VuePrint is 
started from the File Manager (i.e. has file names on the 
command line).    The current directory can be overridden by the
/directory=xxx command line option.

Save options saves the current setting of all options in VUEPRINT.INI in the 
Windows directory. 

Restore options restores all options from VUEPRINT.INI in the Windows directory. 

Default options sets all options to their default values.    If you want to save 
these default settings in VUEPRINT.INI, choose <Save options> 
after this. 

Remember options saves the current setting of all options when the program exits.

Frames across... lets you enter the number of images to display in frames in a 
window in the horizontal direction. 

Frames down... lets you enter the number of images to display in frames in a 
window in the vertical direction. 

Frames random displays images in frames in random positions on the screen.    
The size of these frames is determined by the number of frames
across and down.    This option has no effect if both the number 
of frames across and down are set to 1. 

Frames annotate displays the file name of the image at the bottom of the frame.   
This option has no effect if both the number of frames across 
and down are set to 1, or if the <Frames random> option is 
selected. 

Fill window removes the border and menu bar from the window.    You can 
toggle this on and off by pressing the Escape key. 



JPEG Menu
The JPEG menu provides commands to control the reading and writing of JPEG files.

Two pass causes JPEG files to be read in two passes. The first pass 
analyzes the colors, and the second pass reduces the data from 
24-bits to 8-bits per pixel.    If this option is turned off, the full 
24-bits per pixel will be stored in memory. Note that only 8-bits 
per pixel will be kept in memory if the <Use Monochrome> 
option is selected, or if the JPEG file only has one color 
component.    Note also that the image will still look quite good 
on an 8-bit display if this option is not chosen.    If the <Two 
pass> option is not selected, images will load a bit faster, but 
will take a bit longer to be painted on the screen on 8-bit 
displays.    However, very large JPEG files will load much faster 
with this option turned off because the JPEG code will not need 
to write a temporary file between passes. 

Use dithering enables using Floyd-Steinberg dithering with the two-pass 
algorithm. 

Use monochrome enables converting the JPEG file to 8-bits per pixel of 
monochrome data when loading. 

Block smoothing causes the 8x8 blocks to be smoothed before transforming 
them from the frequency domain. 

Pixel smoothing causes the 8x8 blocks to be smoothes after transforming them 
from the frequency domain. 

Write GIF causes a GIF file to be written for every JPEG file that is read.    
When this option is selected, the two pass algorithm is always 
used. 

Output monochrome causes JPEG files to be written in monochrome (black/white). 

Output optimize performs entropy optimization when writing JPEG files, which 
should improve the quality of the image. 

Output quality... lets you set the quality of the image when writing a JPEG file.    
The quality ranges from 0 to 100, with 75 being the normal 
setting.    The lower the quality, the smaller the size of the JPEG 
file. 

Output smoothing... lets you set the amount of smoothing done on the image before
writing a JPEG file.    The smoothing ranges from 0 to 100, with 0
being the normal setting.    Smoothing is sometimes useful when
the image is dithered, or has a lot of noise in it. 



Utilities Menu
The Utilities menu provides commands to install and remove VuePrint, and to install, 
remove, and configure the VuePrint Screen Saver.

Install VuePrint saves current File Manager associations, sets up associations for
VuePrint, copies VUEPRINT.EXE and VUEPRINT.HLP to the 
Windows directory, deletes VUEPRINT.INI from the Windows 
directory, and installs the VuePrint icon in the Accessories 
window.

Remove VuePrint reverses the above, restoring the system to the original state.    
The files VUEPRINT.INI, VUEPRINT.EXE, and VUEPRINT.HLP are 
not deleted and the icon is not removed if the running program 
is running from the Windows directory.

Install Screen Saver installs VuePrint as a screen saver for Windows.    VUEPRINT.EXE 
is copied to VUESAVER.SCR in the Windows directory, and 
VUEPRINT.HLP is copied to VUESAVER.HLP.    VUESAVER.INI is 
deleted.

Remove Screen Saver reverses the above, disabling the Windows screen saver.    The 
files VUESAVER.INI, VUESAVER.EXE, and VUESAVER.HLP are 
deleted from the Windows directory.

Configure Screen Saver lets you specify the options for the VuePrint screen saver.    
These options are stored in VUESAVER.INI in the Windows 
directory.    Note that any option that can be set up in 
VUEPRINT.INI can also be put into VUESAVER.INI.    The only 
difference between the two option files is that the default 
options for the screen saver are different from the default 
options for VuePrint.

Test Screen Saver starts the currently installed screen saver.    If you have installed
the VuePrint screen saver, it will be started.    Otherwise, 
whatever screen saver that is installed will be started.



Help Menu
The Help menu provides commands for getting help and registering VuePrint.

Contents... displays the table of contents of this Help file. 

Using help... displays help about the Help program. 

About... displays information about registering VuePrint, and lets you 
enter a VuePrint serial number. 




